
READ ME for PB Bear's Birthday Party 1.0 (Windows version) and the DKMM Sampler

-=-=-=-=-=-=-=-=-=-=-=-=-=-=-
Hints About Reading This File
-=-=-=-=-=-=-=-=-=-=-=-=-=-=-

In Write, maximize the window, to make sure you can see all the text in a paragraph. To move 
round the file, press Page Up and Page Down, or click in the vertical scroll bar. You can print this 
file by selecting the Print command from the File menu.

-=-=-=-=-=-=
Introduction
-=-=-=-=-=-=

This file contains information about installing and running  PB Bear's Birthday Party and Sampler 
disc. It's organised in the following sections:

A. Installing PB Bear's Birthday Party  and Sampler disc
----------------------------------------------------------------------------------

B. Video Display Notes
----------------------------------

Some things to try if images display incorrectly, or you have display driver errors.

C. Audio Problems
---------------------------

How to resolve some common sound problems.

D. CD-ROM Problems
--------------------------------

Solutions to some problems people have with CD-ROM drives.

E. Running out of memory or running slowly
---------------------------------------------------------------

Things you can try to help PB Bear's Birthday Party run when there is little memory available.

F. Printing and copying
---------------------------------

Some notes on printing and copying PB Bear's Birthday Party images.

G. DKMM Sampler 
----------------------------



A. General system requirements for running the Sampler

B. Other important issues for PC Users

C. List of Director 4.04-compatible video and sound cards 

More help on making the best use of all the features within PB Bear's Birthday Party is available 
once you have started the product. Click on PB Bear at the bottom of page one then on the Help 
for parents picon. Click on 'Having Problems?' to access more information (you will also find a 
reminder of some of the main points in this README.WRI).

If you need further technical support on any Dorling Kindersley product, please call the 
Multimedia Helpline with details of the problem, including any error messages that were 
produced, and the full specification of your computer. 

The numbers in New York, USA are: 

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: DKMM@phantom.com

The numbers in London, United Kingdom are: 

Telephone: 0171 753 3488
Fax: 0171 753 7575 

-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=
A. Installing PB Bear's Birthday Party 
=-=-=-=-=-=-=-=-=-=-=-=-=--=-=-=-=-=-=

Users who DON'T already have Video for Windows (TM) installed will require approximately 4 Mb
of space on their hard disk to install PB Bear's Birthday Party and Sampler disc.  (Users who DO 
already have Video for Windows will only need 1.6 Mb of free space. Once you have checked this
space is available you should: 

1. Insert the disc into your CD-ROM drive.
2. Under Program Manager, choose Run from the File menu.
3. Type d:\setup (if d is your CD-ROM drive).
4. Click OK and follow the instructions.

-=-=-=-=-=-=-=-=-=-=-=-=
B.  Screen Display Notes
-=-=-=-=-=-=-=-=-=-=-=-=

Screen Resolution
--------------------------

Dorling Kindersley Multimedia products have been designed to look their best with a screen 
resolution of 640 x 480 pixels.  All screen images are created in this size, and will completely fill 
the screen at this resolution. This means that running your screen at a higher resolution (such as 
1024 x 768) will result in a smaller image of PB Bear's Birthday Party being displayed. (It is NOT 



possible to maximise the product to fill screens with a resolution higher than 640 x 480.)

256 Colors
---------------

PB Bear's Birthday Party uses 256-color images and we recommend that you set your display 
driver to 256-color mode and 640 x 480 format.  This will ensure that you can display PB Bear's 
Birthday Party in full screen format. You can run the Windows Setup program to change your 
display driver. For more information, check your Windows documentation.

16 Colors
-------------

If your computer is running in 16-color mode, and your display card supports 256 colors, you can 
run the Windows Setup program to change the display driver. This will enhance the image quality 
of PB Bear's Birthday Party.

Images appear in monochrome
--------------------------------------------

Some color display cards may display PB Bear's Birthday Party images in black and white. If this 
happens, you should upgrade your color display driver. Contact the supplier or manufacturer of 
your display card to check that you have the latest display drivers.

Images are truncated
------------------------------

The designs of some display drivers are to provide large fonts. If your system is using one of 
these, any images in the main window will appear slightly truncated. You can run the Windows 
Setup program to change the default display driver to one that does not default to large fonts.

ATI cards
--------------

Some of the advanced features of ATI cards may be incompatible with PB Bear's Birthday Party. 
In particular, for the more powerful ATI cards, you may find that the "256 color palette" of the "ATI 
Control Panel" must be set to ON. For more information, see your display card documentation.

Other display problems
---------------------------------

If you continue to have problems displaying images or running animations in PB Bear's Birthday 
Party, you may be able to isolate them by going through the following process:

1. Run the Windows Setup application, and check your display driver. If it is VGA, then try running
Windows in Standard Mode by exiting and typing "WIN /S" at the DOS prompt. If PB Bear's 
Birthday Party works, then try running Windows in enhanced mode by exiting Windows and 
typing "WIN /D:XV" at the DOS prompt. If this also solves the problems, then edit the "[386Enh]" 
section in your SYSTEM.INI file so that these entries read:



   EMMEXCLUDE=A000-EFFF
   VIRTUALHDIRQ=OFF

2. If the display driver shown in the Windows Setup application is not VGA, then try using the 
"Change Systems Settings..." in the Options menu to change the display driver to VGA. If this 
solves the problem, consider using a different display driver provided by your display card 
manufacturer. If not, you should contact your display card manufacturer for advice.

Remember that PB Bear's Birthday Party uses 256-color images, and will not look its best using 
the 16-color mode of the standard VGA driver.

WinG - Windows Games Interface
--------------------------------------------------

This product uses the WinG Windows Games Drivers. This is installed if necessary during Setup. 
When you first run the product, WinG tries to profile your display for optimum performance. This 
takes a couple of minutes. It is only performed once. Certain older video display drivers may not 
be compatible with WinG, in which case you should get the following message when you try to 
start up the product:

"WinG has encountered a problem with your video display driver. Contact the manufacturer of 
your video card to obtain the most recent driver. Your WinG applications will run, but at reduced 
speed."

We recommend that you obtain and install the most recent driver for your video card for best 
results, although installing the standard Windows SVGA 640 x 480 x 256 color driver works well 
on the machine configurations tested at Dorling Kindersley Multimedia.  If you are concerned that 
PB Bear is not displayed full screen then you should  run the product in this mode . You can run 
the Windows Setup program to change your display driver. For more information, check your 
Windows documentation.

Users with Cirrus Logic cards, models 5426/5428 who are having problems with their drivers 
might like to install the most up-to-date driver available to us in the public domain. We have 
included the drivers for these popular video cards, as well as the generic Windows SVGA driver, 
in the WINGDRV directory on the CD-ROM. These may be helpful but we should point out that 
they are not produced by Dorling Kindersley Multimedia and are unsupported by us. For more 
information on how to install drivers, check your display card documentation or contact your 
supplier.

-=-=-=-=-=-=-=-=-=
C.  Audio Problems
-=-=-=-=-=-=-=-=-=

There are many possible causes of audio problems. Remember, for example, that your computer 
can only play one sound at a time, so when another application is playing a sound, PB Bear's 
Birthday Party cannot do so. Most applications are well behaved and only prevent other programs
from playing a sound when they themselves are doing so. However, some applications, such as 
certain Screen Savers, remove audio capability from all other Windows applications. If you have 
such an application, you should deactivate it when you are running PB Bear's Birthday Party. 
Also, PB Bear's Birthday Party DOES require a sound card to be present, as all the animations in 
the product are synchronised to run frame-by-frame with their accompanying soundtrack.

Audio is fuzzy or distorted
-------------------------------------



There are a number of possible causes of fuzzy or distorted sounds. Problems are often caused 
by low-quality speakers, speakers set to high or maximum volume, or speakers powered by 
failing batteries. You should also be aware that some speakers are not capable of playing low 
frequency sounds properly.

If the software supplied with your sound card allows you to change settings you should check 
them to see if they are causing the distortion. 

Some sound cards have software that allows you to adjust the volume AND tone of the sound; 
start with these tone controls set in the mid position and your volume level set between 80% - 
100%. This should give a clear signal with no distortion.

If treble or bass is adjusted in this software you must reduce the volume to compensate, or 
distortion will occur. Check your sound card manual for the optimum settings.

Powered speakers are best and, if possible, should be placed either side of the screen. You may 
need to adjust the position of these speakers slightly if the magnets in the speakers are 
unshielded and cause discoloration and distortion of the image.

If your CD-ROM is not MPC compatible, then the sound may play badly or be interrupted when 
playing. Check your CD-ROM's documentation to ensure that it meets the following requirements:

- It has an average seek time of less than one second;
- It has a transfer rate of at least 150KB per second while using less than 40% of the CPU 
bandwidth.

Sound plays too quietly
----------------------------------

Make sure the volume is set to an audible level. Check the sound card itself, the speakers or 
headphones if they have a volume control, and any software that may have been supplied with 
your sound card that can change the volume level.

If sound is set to an audible level, then you may have a problem with the set-up of your sound 
card drivers. Check they are set up correctly (from the Drivers section of the Control Panel) and, if
necessary, reinstall them. Consult your sound card documentation for more detailed information.

PB Bear's Birthday Party WILL NOT work with sound drivers that drive the internal "PC Speaker."

EISA machines
----------------------

If you are running PB Bear's Birthday Party on an EISA machine, and the sound appears 
scratchy, you should change the DMA channel on the sound card to DMA 7. Consult your sound 
card documentation for more detailed information.

Media Vision sound cards
--------------------------------------

Please make sure that you have the latest drivers for your Media Vision sound card. Some earlier
drivers cause problems for PB Bear's Birthday Party. Contact Media Vision for current driver 
information.



-=-=-=-=-=-=-=-=-=-==
D.  CD-ROM Problems
-=-=-=-=-=-=-=-=-=-==

If PB Bear's Birthday Party has problems finding the data files it needs from its Compact Disc, 
you will see a message asking you to select the drive that contains the files. To find what has 
caused the problem, do the following:

1. Ensure that the PB Bear's Birthday Party CD has been correctly inserted into the CD-ROM 
drive.

2. Check that PB Bear's Birthday Party is looking in the right place for the Compact Disc drive. If, 
for example, the drive letter has changed as a result of a system change (such as adding or 
removing a RAM-disk or other device) then PB Bear's Birthday Party will fail to find the CD-ROM. 
You can check that the drive letter is correct by using Windows File Manager to see which letter is
assigned to the Compact Disc drive.

3. If you have an external Compact Disc drive, make sure that it is plugged in, turned on, and 
connected to your computer. You may need to check the documentation that came with the drive.

4. Verify that your Compact Disc drive is MPC-compatible, and meets the following requirements:

- It has an average seek time of less than one second;
- It has a transfer rate of at least 150KB per second while using less than 40% of the CPU 
bandwidth.

-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=
E. Running Out Of Memory Or Running Slowly
-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=

PB Bear's Birthday Party uses your computer's system memory to display pictures.  If you find 
that PB Bear's Birthday Party runs slowly or if you come across out-of-memory errors, the 
program probably does not have enough memory.  Consider doing the following to improve your 
computer's performance:

1. Close any unnecessary applications, including any DOS TSR's you may have installed.

2. If you still cannot run PB Bear's Birthday Party on a 256-color display, try switching to the 16-
color Windows VGA driver. For instructions on how to change your Windows display, consult your
Windows documentation. Note that images used by PB Bear's Birthday Party are 256-color, so 
they do not look their best in 16-color mode.

3. Check that your computer has at least 4MB of memory. You can do this by leaving Windows, 
and typing "mem" at the system prompt. If you have less than 4MB of memory, then you need to 
install some more.

4. Check that Windows has 4MB of memory available for PB Bear's Birthday Party. You can do 
this by selecting "About Program Manager" from the "Help" menu in Program Manager. You may 
find more memory becomes available if you restart Windows.

5. If you are running DOS 6.0 or higher, then you can run the MEMMAKER  utility to optimise the 



memory in your computer. (For example, if you answer 'No' to the question 'Do you use any 
programs that need Expanded Memory?', MEMMAKER will free further conventional memory by 
inserting the switch NOEMS in the appropriate line in your PC's CONFIG.SYS file.) Consult your 
Windows documentation for further information on using MEMMAKER.

6. If you are running Windows in Enhanced mode, set up a permanent Windows swap file on your
hard disk. You can do this by following the instructions in your Windows documentation.

7. On machines with only 4MB of memory, restrict the SMARTDRV setting that controls the size 
of the disk cache for use inside Windows to 512K or less. If you are running Windows for 
Workgroups 3.11 and using 32-bit disk access,  make sure that the SMARTDRV settings in your 
AUTOEXEC.BAT file enable SMARTDRV to cache your CD-ROM drive efficiently. Consult your 
Windows documentation for further information on how to check and adjust these settings.

8. Clean up your hard disk by defragmenting it. There are a number of tools available to carry out 
this task, including the DEFRAG command found in DOS version 6 and later.

-=-=-=-=-=-=-=-=-=-=-=
F. Printing and Copying
-=-=-=-=-=-=-=-=-=-=-=-

Printing screens from PB Bear's Birthday Party may take several minutes, depending on the type 
of printer you use. Since screen resolution and printer resolution are often different, the printout 
may not match the quality you see on the screen. 

You can change the settings of your printer from within PB Bear's Birthday Party by clicking on 
the Bear icon, which is located in the centre and at the bottom of each page. Select the 'Parents' 
icon and follow the instructions for printing. (Please note: an explanation of the Print Setup dialog 
box is available in your Windows documentation.)
Some dot-matrix printers may not print pictures properly with the "Low/Faster" quality setting in 
the Print Setup dialog box. On these printers change the quality setting in the "Printer Settings..." 
dialog box to "High/Slower."

Because the pictures can be quite large, you may have difficulty copying or printing in low-
memory conditions.  In this case, follow the advice in section D of this file, and try again.

To copy an active window, select 'Parents' as before.  Click ONCE  on 'Copy Active Window'. To 
view your copy switch to the 'Windows Program Manager' and open 'Main'. Open 'Clipboard 
Viewer' to see your copy.

=-=-=-=-=-=-=-=-=-=
G.  DKMM Sampler
=-=-=-=-=-=-=-=-=-=

A General system requirements  for running the Sampler
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=

The Sampler on this disc has been created using Macromedia Director (TM) 4.04 for 
Windows. The recommended PC configuration to run Dorling Kindersley Multimedia's Sampler is 
as follows:

486SX 25 MHz IBM or compatible PC
8Mb of RAM



Double-speed CD-ROM drive
Sound card, mouse, hard disk
SVGA 256-color display 
Loudspeakers or headphones
Microsoft Windows (TM) 3.1 or later

However, DKMM's Sampler will run on lower specification machines, but it will run more slowly, 
and below the speed of the actual titles.

(Most of the titles featured should run on 386 machines with 4Mb of RAM and a single-speed CD-
ROM drive. Please check individual box details for the exact specification of each title.)

Users should also be aware that Director requires sound cards, video software drivers and 
hardware that fully support Windows 3.1 standards. Guidelines on appropriate video and sound 
cards have been taken from Director 4.04 technical documentation and included in section C of 
this README file. 

B. Other important issues for PC Users of DKMM Sampler
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-

1. Certain video and sound cards that have NOT been tested by Macromedia may 
experience problems running the sampler. For example, users with Cirrus cards and older Cirrus 
drivers may find Dorling Kindersley Multimedia's Sampler crashes or otherwise behaves badly. 
(Replacing the driver with a newer Cirrus driver may solve the problem.  Alternatively, replace the 
driver with the generic Windows SVGA 256 640x480 color driver.)
Contact the manufacturer of your particular video or sound card for details of their most up-to-
date drivers if you experience any problems. Consult the Windows documentation supplied with 
your computer for more information on how to change drivers if necessary. 

2. For the technically minded, the sound sample rate used for narrations and animations in the 
sampler is 11.025 KHz. (This is a space-saving requirement.) In the final products the sample rate
is 22.050KHz, giving superior audio quality.

3. DKMM's Sampler uses 256-color images and will not look its best if your computer is running in
16-color mode. We strongly recommend that you set your display driver to 256-color mode if you 
have not already done so, should you be concerned that you are not viewing PB Bear full screen 
then we advise you adopt this display mode. You can run your Windows setup program to change
your display driver. For more information check your Windows documentation. (Users with 
Windows 3.1.0 may need to obtain the necessary 256-color drivers from Microsoft.)

C. List of Director 4.04-compatible video and sound cards 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=

1. Video Cards

Director requires video software drivers and hardware that fully support Windows 3.1 standards. 
The following video systems have been tested and found to be compatible with Director during 
authoring and playback. We recommend installing the latest available video ROM and software. 
Contact the video card manufacturer for information.

Authoring and playback are not limited to these systems. If you experience difficulties with a card 
that is not on this list, first test it at 640 x 480 resolution with the monitor's color depth set to 8-bit 
(256 colors). Next, contact the hardware manufacturer to find out if the problem has been 



addressed with an updated driver.

The following cards have been tested and provide acceptable results for authoring and playback:

Bus Driver
Video card Type Date  Rev

ATI Graphics Wonder VLB 3/19/93  2.3
ATI Graphics Xpression VLB 6/13/94  1.1

(See Note 1)
Compaq QVision 1024/I ISA 1/18/94  7.40
Diamond Viper PCI 9/27/93  3.01

(Recommended)
Diamond Viper VLB 9/17/93  2.01
Genoa Windows VGA 24 VLB 8/8/93  1.7
Headland Video 7 RAM II VGA ISA 5/15/92  3.10
Hercules Graphite Pro VLB 12/29/93 2.21
( See Note 2)
IBM XGA-2 MCA 11/12/93 2.11

(See Note 3)
Number Nine 9GXE64 PCI 6/22/94  1.19.04

(Recommended)
Orchid Fahrenheit 1280 ISA 8/10/92  3.0
RasterOps PaintBoard PC ISA 3/25/93  3.10

(See Note 2)
Spider Black Widow VLB 1/20/94

(Recommended)
Trident 8900C ISA 9/23/92  3.10
Trident 9000C ISA 7/8/93 VC4.5(WC1.6) 

(See Note 2)

Note 1: Set DeviceBitmaps=OFF in the Windows SYSTEM.INI file [MACH] section 
after card software installation if using this driver version.
Note 2: Use in 256-color mode only.
Note 3: This card does not draw extremely wide arcs properly.

The following video cards have been tested and provide acceptable results for playback:

Bus Driver
Video card Type Date  Rev     

Actix ProStar VL VLB 8/18/93  1.42          
(See Note 1)

ATI Graphics Ultra ISA 3/19/93  2.3
ATI Graphics Ultra Plus ISA 4/25/94  2.3
ATI Graphics Ultra Pro VLB 4/25/94  2.3
ATI Graphics Ultra Pro ISA 4/25/94  2.3
Blackship Color DesignerA3 VLB 7/8/93  1.32
Diamond Speed Star Pro ISA 2/17/94  1.08
Diamond Speed Star VGA ISA 4/14/92
Diamond Stealth 24 VLB 6/3/94  3.00
Diamond Stealth Pro VLB 10/6/93
Elite Group GD5426/28 VLB 8/18/93  1.32b
ELSA Winner2000 Pro PCI 6/23/94  1.22
Hercules Dynamite Pro ISA 12/1/93  2.10           



(See Note 2)
Hercules Dynamite Pro VLB 12/1/93  3.00
Hercules Graphite Power ISA 4/6/94  2.10
IBM XGA Display MCA 11/12/93 2.11

(See Note 3)
Matrox MGA Power Graphics PCI 3/28/93  1.42
Media Vision ProGraphics 1280 VLB 9/15/93  1.01
Media Vision ProGraphics 1024 VLB 4/15/94  1.5
Mitac MVA-CL5428-1MB VLB 3/15/94  V1.43
Number Nine 9GXe Level 10 ISA 2/9/94  V3.11

(See Note 4)
Number Nine 9GXe Level 11 VLB 2/9/94  3.10.061 

(See Notes 4, 5)
Number Nine 9GXe Level 14 VLB 4/7/94  3.15

(See Note 4)
Number Nine 9GXE64 VLB 6/22/94  1.19.04

(Recommended)
Orchid Celsius VLB 10/1/93  1.32

(Recommended)
Orchid Fahrenheit 1280 Plus VLB 3/1/94  rel 7 

(See Note 6)
Orchid Fahrenheit VA VLB 4/29/93  5.01
Orchid Kelvin 64 PCI 3/14/94  1.1
Orchid Kelvin 64 VLB 2/23/94  1.21
Orchid ProDesigner IIS ISA 3/1/92  2.0
Paradise WD90c33 VLB 6/28/93  1.2
Standard 1Mb-24X ISA 3/19/93  1.30
STB Horizon VL Pro VLB 6/29/93  1.3
STB Lightspeed PCI 12/1/93  1.1
STB Pegasus VLB 11/29/93 1.3
TrueVision Bravado 8 ISA 1/15/92

Note 1: Driver version 1.53 sometimes freezes when playing certain Director 
transitions. Driver version 1.42 is recommended.
Note 2: Does not always properly display QuickTime digital video in 16-bit (thousands) and 24-bit 
(millions).
Note 3: Does not draw extremely wide arcs properly.
Note 4: Sound break-up or distortion may occur during complex transitions.
Note 5: The cursor sometimes disappears when using a large virtual desktop.
Note 6: Video snow appears during some palette transitions.

2. Sound Cards

The following sound cards have been tested and are compatible with Director:

Sound Card

Compaq Business Audio
Creative Labs SoundBlaster
Creative Labs SoundBlaster Pro
Creative Labs SoundBlaster 16
Creative Labs SoundBlaster AWE32
Gateway 2000
IBM M-Audio * 
MediaVision ProAudio Spectrum
MediaVision ProAudio Spectrum 16



MediaVision ProAudio Spectrum 16 Pro
Microsoft Windows SoundSystem Version 1
Microsoft Windows SoundSystem Version 2
Orchid SoundWave 32
Reveal Forte 16
Roland Rap-10

*  IBM computers that have the M-Audio sound card should use driver version 1.3 or higher for 
best results. Older versions of this driver don't play all sounds in Director or AVI movies. The 
version 1.3 driver did not pass the 16-bit sounds test for Director. Testing revealed that 8-bit 
sounds are corrupted when played after a 16-bit sound. At the time these release notes were 
written, version 1.3 (dated 1/10/94) was the most recent driver available from IBM.

(c) Dorling Kindersley Multimedia
May 15th, 1995


